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Welcome to the latest edition of my monthly Final Cut Studio newsletter for May, 2010.

The goal of this newsletter is to provide information helpful to the interested user of Final 
Cut Pro. This newsletter publishes each month. Past issues are available in my store. All 
software references are to Final Cut Studio (3) unless otherwise noted. 

Please invite your friends to visit my web site -- www.larryjordan.biz -- where you'll find 
daily tips, the latest industry news, and almost 500 articles and tutorials to help you get 
the most out of Final Cut Studio!

If you haven't done so already, each issue of this newsletter is FREE -- subscribe here. Then, follow us 
online: 

�●     Larry on Facebook
�●     Larry on Twitter
�●     Latest Industry News from the Digital Production Buzz
�●     Larry Jordan's Blog 

NEWSLETTER CONTENTS

�●     Welcome
�●     Creating DVD Studio Pro Menu and Button Highlights Using Photoshop Layers
�●     More New Webinars From Larry Coming In June
�●     Picking The Right Version of ProRes For Your Project
�●     New Video Tutorials And Bundles! 
�●     Review: Photomotion From Geethree
�●     Report: Fixing Corrupted Project Files
�●     What Does 64-Bit Really Mean?
�●     Thoughts on The Latest Tumult - Whither Goest Final Cut Pro?
�●     A New Way To Create Call-Sheets
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�●     Understanding AVCHD Discs
�●     A Testimony to Blu-ray Discs

PASSING THOUGHTS

Short notes on interesting subjects.

�●     Updated Article
�●     Animating Text
�●     Free Stuff
�●     Looonnnggg Renders
�●     AVI Codec
�●     Flying People Without Wires

READER MAIL

�●     Transcoding AVCHD
�●     An Analogy For Bit-Depth
�●     Droplets vs. Compressor
�●     Exporting H.264 Videos
�●     Avoiding Dropped Frames
�●     ProTools vs. Soundtrack Pro
�●     Creating an Audio CD In Soundtrack Pro
�●     DVD Studio Pro Importing
�●     Changing Incorrectly-Sized Anamorphic Footage
�●     Using EDLs With Tapeless Media
�●     A "Keyframe Everywhere" Command
�●     Question About Activity Monitor

WRAP-UP

WELCOME

I'm writing this over Memorial Day weekend, so as long as I get 
this out by midnight Monday, it still qualifies as the May issue. 
Barely.



We've got a lot of new stuff that we are working on - some we've already announced, others we will be 
announcing next month. Making a lot of these new web goodies possible is the newest member of our 
team, our webmaster: Mina. We are delighted she has joined us as we have a lot of plans to grow our 
web presence and she will be a key part of this.

Also, we've begun a new training series -- this time, web-based -- and I'm delighted with the response 
so far. These live, hour-long, interactive audio and video tutorials are a convenient, low-cost way to 
improve your skills. We will be extending these web seminars into weekly events, starting the end of 
June. I'll send you topics and times later this month. I'll talk more about these webinars later in this issue.

Over the last year, we have created a range of training products that meet a variety of budgets and 
training needs - from simple, downloadable tutorials, to web-based seminars, to on-site custom training, 
to hands-on classroom-based training through our partnership with DV Creators.net.

Plus, we now have the ability to provide remote training via screen sharing for people that need specific 
help, but don't have the time to attend a class. Contact our office to learn more.

Keeping you informed on our industry, and helping you sharpen your Final Cut Studio skills is a key 
focus for me. So, let's get to it by looking at a traditional problem from a new perspective - creating DVD 
button highlights using Photoshop layers.

[ Go to Top. ] 

CREATING DVD MENU AND BUTTON HIGHLIGHTS  
USING PHOTOSHOP LAYERS

Two types of menus can be created for a DVD: stationary menus with highlights and motion menus with 
highlights. 

Motion menus are, generally, created in Final Cut Pro and the highlights are created in Photoshop. I'll 
talk about how to create them in a future article.

NOTE: DVD Studio Pro also supports what's called a Layered Photoshop menu. This 
allows you to change the look of your menu, by switching from one Photoshop layer to 
another when clicking a button. While cool, this technique is very, very slow and not 
encouraged for general DVD use. However, if you are building a kiosk appication, where 
files play from a hard disk, this technique is worth looking into. This tutorial, however, 
discusses a much faster way to display highlights, suitable for use on DVDs.

This article looks at how to create good-looking menu and button highlights in Photoshop for use in 
DVD Studio Pro. (While you can easily use DVD Studio Pro's templates, I am not a fan of them, as it is 
easy to create your own menus in Photoshop which provide you more control and customization.)

NOTE: This tutorial applies for both DVD SP 3 and 4, as well as all versions of 
Photoshop since version 5; and probably earlier.

THE WORKFLOW

Here's the workflow in Photoshop:

1. Create your menu at a size specific to your video format 
2. Design your background image 
3. Design your buttons 
4. Design your highlights 
5. Resize the image 
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6. Save the image

Then, here's the workflow in DVD Studio Pro

7. Import the image 
8. Add it to a menu 
9. Select the layers for the background 
10. Select the layers for the button highlights 
11. Draw buttons 
12. Set the color of your highlights.

WORKING IN PHOTOSHOP

Because video images and computer images don't use the same pixel aspect ratios, you need to design 
your menus in Photoshop to compensate for these differences. 

This is similar to what we need to do in Final Cut when preparing still images. However, there's a 
problem. Final Cut and DVD Studio Pro (DVDSP) don't use the same math to calculate image aspect 
ratios. They should, but they don't. So, some of the numbers we have memorized for Final Cut don't 
work.

NOTE: Also, the Photoshop Film & Video presets in Photoshop don't work properly for 
DVD Studio Pro either. They are close, but not exact.

First, create an image in Photoshop according the table below:

Video Format Master image Scaled Image
NTSC   

4:3
720 x 534 720 x 480

16:9
853 x 480 720 x 480

PAL   

4:3
768 x 576 720 x 576

16:9
1024 x 576 720 x 576

In this example, we will create a 16:9 DVD for NTSC video.

NOTE: All DVDs contain only standard-definition video. If you need to create an HD disc, 
you will need to use the Blu-ray Disc format. That process is totally different from what we 
are describing here and DVD Studio Pro can not be used to create Blu-ray Discs.



In Photoshop, we start by choosing File > New and entering the image size numbers from the table 
above into our document: 853 x 480 x 72. Note that the Preset menu is set to Custom.

For the purposes of this tutorial, I'm going to create a VERY simple menu -- just three buttons and a 
simple background. 

In Photoshop, I've created four layers - the minimum you need is two - just to illustrate the process. You 
can design whatever you want, with as many layers as you need (up to a maximum of 99). 

�●     The blue texture is on Layer 1 - Background.
�●     The gray oval is on Layer 2 - More background
�●     The button text is on Layer 3 - Button text

Highlights are that part of a DVD button that change color when you roll-over them or select them on the 
remote control. The "overlay" is the source image created in Photoshop, the "highlight" is the color of 
the overlay that represents it's "state." 

Button highlights have three "states," each represented by its own color: 



1.  Not selected (normal)
2.  Selected (clicked)
3.  Activated (the Enter button was pressed).

All overlays need to be placed on a single Photoshop layer, in exactly the position you need them for 
your menu. You can not reposition them later. To keep thin lines from flickering, make your overlays big 
and bold. Avoid very thin lines, swirls, or lots of design elements.

You need to create overlays using one of three very specific color sets:

1.  Pure black for that which changes color and white/transparent for that which doesn't.
2.  Four shades of gray: 100% white, 100% black, 66% black, and 33% black.
3.  Four specific colors: 100% white, 100% red, 100% blue, 100% black.

In all three cases, DVDSP will replace the source colors with highlight colors, which you get to select. 
Also, highlights must NOT contain any shadows or shade of gray. Anti-aliasing is not supported. 
Highlights are very, very simple graphically. Put your design skills to work in the backgrounds and 
button text, not in the highlights. Simple geometric shapes work best.

NOTE: Changing the color of button text, while possible, looks ghastly. The lack of anti-
aliasing makes edges blocky and the highlight never precisely fits over the underlying 
text. This is why virtually every commerical DVD does not change text color, but uses a 
shape next to the button text to indicate the highlight. 

In this example, I created very simple geometric shapes to use as overlays. I used the chroma method - 
red, blue, black - which allows me to play with more colors in DVD SP. (This image also displays the 
text, so you can see the spatial relationship. However, all overlays are on one layer and all text is on a 
separate layer.)

NOTE: For the commercial titles I create, I generally only use black overlays. The 
purpose of an overlay is to show what will happen when you press the Enter button. It is 
an indicator, nothing more. For this reason, I tend to keep them simple.

Notice all the overlays are in their final position.

Finally, when the menu design is complete, we need to resize the image so that it is ready for importing 
into DVD SP and correct for the differences in pixel aspect ratio. This is a key step -- if you don't resize 
the Photoshop document, your text will look moth-eaten and ugly.



To do this, go to Image > Image size and turn OFF Constrain Proportions. Set the menu at the bottom 
ot Bicubic Sharper, to keep edges looking sharp.

�●     For NTSC video, resize the graphic to 720 x 480, for both 16:9 and 4:3 sequences.
�●     For PAL video, resize the graphics to 720 x 576, for both 16:9 and 4:3 sequences.

Keep the master file, and save a copy -- the resized graphic for import into DVD SP. After you resize it, 
the image will look squished. This is OK, as it will be properly sized inside DVD SP.

WORKING IN DVD STUDIO PRO

Import the graphic into DVD SP. Switch to the Graphical tab and drag the image from the Assets tab 
into the Menu icon of your choice.



The menu will automatically configure itself to 4:3 or 16:9. If it doesn't, you can change how it is 
displayed using the Inspector. (I'll show you how in about two steps.)

Double-click the menu icon in the Graphics tab to load it into the Menu window.



In the Inspector, click the Menu tab and check all the layers you want to appear as the background of 
the menu. In our case, I checked every layer except the overlay layer because I want them all displayed 
in the background.

NOTE: This is also the tab to use if you need to change the aspect ratio of an image -- 
adjust the Display Mode to 4:3 or 16:9 Letterbox (ignore the other two 16:9 settings).



Click the General tab and select the file containing the button overlays. In our case, this is the same 
PSD file that we used to create the menu background.



Select the layer in the PSD file that contains the actual overlays. Since you can only reference one layer 
in this menu, this is why all overlays need to be created in a single layer in Photoshop.

Using your mouse in the Menu tab, drag out a rectangular button so that both the button text and the 
overlay graphic are contained within it.

NOTE: You can view each of the three states of a selected button by clicking one of the 
button state buttons in the lower right corner of the Menu tab window.



With a button selected, go back to the Inspector and select the Colors tab. This allows you to specify 
whether your source overlays are:

�●     Black only: Select Overlay Colors: Simple
�●     Shades of gray: Select Overlay Colors - Advanced, Mapping Type: Grayscale
�●     Primary colors: Select Overlay Colors - Advanced, Mapping Type: Chroma

In my example, I'm using Advanced and Chroma. 

Finally, for each of the three selection states - Normal, Selected, Activated - set highlight colors to map 
to each of the three colors in your button. (There are actually four colors, but white is generally used to 
represent the transparent portion of the image, which means we have three remaining colors to play 
with.



 

Here's an example of some settings, and what the resulting button colors look like.

Continue adjusting colors and opacity until you are happy with the look.

CONCLUSION

By integrating button overlays into the source file of your menu, you have fewer files to worry about, 
your image alignment is always correct, and you can always use "Open in Editor" to go back to 
Photoshop to make tweaks.

I find this to be a very efficient technique to use in creating DVD menus. Again, while I tend to always 
use overlays with one key color (black) for simplicity, you can pick the design style that works the best 
for your projects.
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NEW! MORE WEBINARS FROM LARRY COMING IN JUNE

We launched our latest training series two weeks ago - web-based PowerUP 
seminars - and they were very successful!

Web-based training is less expensive (for both of us) than in-person training; 
plus, with our live chat and video, it is highly interactive.

We are so excited about these that we are repeating our sessions twice more 
this month - Saturday, June 5 and Wednesday, June 9! Click here to learn 
more.

All you need is a web browser and an hour of time. We have three subjects we'll be covering 
immediately:

* Avoiding Dropped Frames -- Picking the Right Storage System 
* Prepping and Moving on Still Images in Final Cut Pro 
* Making Your Video Look More Like Film

Each of these subjects generated lots of interest in my recent seminars and we had dozens of 
attendees in the first round of our webinars.

We are offering each session two more times, on two different days, so you can pick the date and time 

http://www.larryjordan.biz/webinars
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that work the best for you. The content for each webinar is the same.

�●     Avoiding Dropped Frames 
�❍     Saturday, June 5th at 9:00 AM
�❍     Wednesday, May 9th at 6:00 PM

�●     Working with Still Images 
�❍     Saturday, June 5th at 2:00 PM
�❍     Wednesday, June 9th at 9:00 AM

�●     Making Video Look Like Film 
�❍     Saturday, June 5th at 6:00 PM
�❍     Wednesday, June 9th at 2:00 PM

NOTE: All times are Pacific Daylight Time (PDT) -- Los Angeles time.

Each webinar is limited to 50 seats on a first-come, first-serve basis. Each session illustrates specific 
techniques you can put to work immediately, plus an interactive chat so you can ask questions. Each 
session runs one hour.

Click here to learn more and register. Pricing ranges from $29 to $49 per event.

I also want to thank our sponsors - Data Robotics, GeeThree Software, and Red Giant Software - for 
helping us keep registration costs low.
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PICKING THE RIGHT VERSION OF PRORES 422

With the release of Final Cut Pro 7, Apple increased the number of ProRes versions from two to five:

�●     ProRes 422 Proxy
�●     ProRes 422 LT
�●     ProRes 422
�●     ProRes 422 HQ
�●     ProRes 4444

So, that begs the question: which version should you use for your project.

First, four of the five flavors of ProRes are identical in every respect, except one. They all support:

�●     Intra-frame encoding, meaning each frame is individually compressed as a stand-alone picture, 
unlike GOP-based encoding like XDCAM EX or HDV.

�●     Variable bit-rate data encoding, creating smaller files than constant bit rate encoding.
�●     10-bit color depth, for very high color fidelity
�●     4:2:2 chroma sub-sampling, the maximum allowed for video formats
�●     Fast render times, much faster than GOP-compressed video like XDCAM EX or HDV
�●     Faster editing within Final Cut Pro
�●     Matching the frame rate, frame size, and pixel aspect ratio of the source video
�●     Optimized for multiple processor support

Unlike H.264, ProRes encoding and decoding are optimized for multiple processors.

ProRes 4444, the fifth version, builds on the first four ProRes versions, then adds support for the 
following:

�●     RGB or YCbCr color space
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�●     Up to 12-bit color support
�●     Inclusion of the transparency (alpha channel) information in a clip

If you need a clip to retain transparency information, which is called the "Alpha channel," you only have 
one choice: ProRes 4444. None of the other ProRes versions support clip transparency. 

Well, since it's clear that ProRes 4444 is the absolute "best" in terms of quality, it seems like we should 
all just select ProRes 4444 and be done with it.

The problem with this approach is that your file sizes can be quite large, not as large as fully 
uncompressed HD, but still pretty darn big. And, unless you have a specific need for this format, you 
probably won't be able to see the difference between ProRes 4444 and other ProRes versions. Also, 
using ProRes 4444 in your project probably means you'd need to render every shot.

Think of ProRes 4444 as the replacement for the Animation codec. We use the Animation codec when 
we want to move files between one application and another; for example, between After Effects and 
Final Cut. Then, once it's in Final Cut, you render it into the final version you need for your project.

As a transfer format, ProRes 4444 is great. As a video editing format, it's way past overkill. Most of the 
time, you will be fully happy with one of the four other versions. And your file sizes will be much smaller.

The four other versions of ProRes differ in only one area: data rate. Changing the data rate directly 
affects file size and image quality. The slower the data rate, the smaller the resulting file and, 
potentially, the lower the image quality. 

For example, here's a table that showcases the difference. This is just a guide, different formats create 
different file sizes, but the general proportions will be the same.

ProRes Version Store 1 Hour of 720p/60*
ProRes 422 Proxy 20 GB

ProRes 422 LT 46 GB

ProRes 422 66 GB

ProRes 422 HQ 99 GB

ProRes 4444 (no alpha) 148 GB

* Source: Apple Inc. ProRes White Paper, June, 2009.

However, the situation isn't as grim as you might think. Here are some suggestions you can reflect on 
as you are trying to decide what codec to use.

RECOMMENDATIONS

If you are shooting GOP-compressed media - HDV, XDCAM HD, XDCAM EX, AVCHD, AVCCAM - your 
editing and render times will greatly benefit from converting your footage from the source format into 
some version of ProRes. 



At a minimum, when editing one of these formats, select the Timeline and go to Sequence > Settings > 
Render Control and change the codec from Same as Source to Apple ProRes 422. My tests have 
shown that there is about a 40% speed improvement in rendering when you switch to ProRes.

ProRes 422 HQ: This is the highest-quality video format, but unless you are shooting very carefully-lit, 
high-end video, such as RED, HDCAM, or HDCAM SR, the quality of your source image doesn't equal 
the format. Use this version only for high-end work.

ProRes 422: This is the format I recommend for anyone shooting DSLR, HDV, AVCHD, XDCAM EX, 
XDCAM HD, AVCAM, or P2. Great image quality, with file sizes 30-35% smaller than ProRes 422 HQ. 
Since the DSLR images start as H.264, which is already quite compressed, ProRes 422 most closely 
matches the original image quality.

ProRes 422 LT: This is the format to use if you have tons of footage, need to edit using smaller (i.e. 
less storage space) hard drives, or are going to go thru an off-line to on-line process. 

ProRes 422 Proxy: This format should only be used when file size is more important than image 
quality. Training files, library archive files, or other reference media are a good choice for this format. 

NOTE: If you are on an older, non-Intel system, ProRes may not be a good choice for 
you. The math involved is very CPU-intensive and older systems may not be able to 
encode or play it fast enough.

ProRes is an excellent video codec and one that has achieved great popularity in the industry. 
However, that doesn't mean you always need to select the absolute highest quality -- many times our 
images weren't that good to start with.

By spending a few seconds thinking about which ProRes version best matches our video format, we 
can save a ton of time and storage space down the road.
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NEW VIDEO TUTORIALS AND BUNDLES! 

I've created five more video tutorials to help you learn Final Cut. 

First, as we were getting ready for NAB, I created a series of four new tutorials 
on working with multi-track audio in Soundtrack Pro. Over 90 minutes of 
detailed instruction, contained in four new movies.

Plus, I've created one more covering new FCP 7 shortcuts.

I've created more than 60 video tutorials and bundles. These short, focused 
titles can solve your technical questions and get you up and running fast. 

Even better, SAVE MONEY and buy bundles! 

�●     Recording, editing, and outputting multi-track audio using Soundtrack Pro - NEW!
�●     My Favorite Final Cut Pro Tutorials
�●     Video Compression
�●     Soundtrack Pro Bundle #1
�●     Soundtrack Pro Bundle #2

With more than 60 tutorials available, choose from the complete list of my video tutorials here. Most 
tutorials are priced at $4.99 each.

With all these titles, there's sure to be a solution to your nagging Final Cut problems. Most titles run 5-
10 minutes and can be downloaded instantly. 

More titles coming every month! Take a look and order today! 
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REVIEW: PHOTOMOTION 1.5 FROM GEETHREE

Disclosure: GeeThree Software is one of the sponsors of my current webinar series. 
Click here to read my review and disclosure policy.

A few months ago, Bruce Gee, CEO of GeeThree Software, demoed to 
Ken Stone and myself a beta version of a new product he was developing 
that simplified the process of creating moves on still images. (He got the 
idea after watching my tutorials on Lynda.com on creating moves on still 
images; he realized the whole process could be much simpler.)

Both Ken and I were very impressed with what we saw and provided a 
number of suggestions on ways to improve the beta that Bruce took back 
to his development team. He released an improved version a few months 
later, called PhotoMotion.

Since then, Bruce and I have chatted often about this product. I demoed it from time to time in my 
seminars and am currently using it in my webinar on preparing stills for video.

However, I haven't put the product under any heavy stress until this last week, when I was asked to 
create a memorial video uisng about 100 stills. So, Bruce sent me a demo copy of their latest version 
for me to work with.
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There is no question that Final Cut can create moves on stills, however, the process is cumbersome. 
And, due to long-standing bugs in Final Cut, if you start to add acceleration and deceleration to your 
moves, the results can best be described as somewhat erratic.

So, I decided this was the perfect time to put PhotoMotion to the test. This review uses the latest 
version - 1.5 - of the software, running inside FCP 7 under OS 10.5.8.

THE WORKFLOW

In a nutshell, here's the workflow:

1. Organize the images 
2. Store the images in a place that PhotoMotion can find 
3. Start Final Cut Pro 
4. Create your moves using either PhotoMotion or PhotoMotion Producer 
5. Render your finished effects

What I found works best, when dealing with a lot of stills, is to get them organized before even moving 
into Final Cut. I use Adobe Bridge (which is bundled with both Photoshop and Production Premium). 

The benefits to using Bridge are that:

1.  I can see all the images in light-table mode



2.  I can rearrange images in any order I choose.
3.  I can easily add, move, and remove images.
4.  It is a single mouse-click to open an image in Photoshop for retouching.
5.  I can batch rename the images so that, once I have them in the order I want, I quickly add a 

number to the beginning of each file name so that all the images sort in the correct order.

Once I have the images organized and renamed, its time to open Final Cut and get to work.

CREATING A SINGLE MOVE

There are two ways we can create moves: one image at a time, or building a sequence of images. This 
first section looks at how to create a single move, the next section examines creating sequences.

There are a couple of quirks you need to keep in mind when using PhotoMotion:

1.  PhotoMotion is a generator, not a filter. So, it's located in the Generator menu in the lower right 
corner of the Viewer.

2.  You can't drag images from the Browser into PhotoMotion because of programming restrictions 
with Final Cut Pro. This is why we need to create a folder (or group of folders) that contain our 
images in the Finder before starting Final Cut.

From the Generator menu, select SlickFX Generators > PhotoMotion.

BEFORE making any changes, edit this from the Viewer into the Timeline. This tells the generator what 
video format, aspect ratio, frame rate, and all the other technical stuff it needs to match; otherwise, you'll 
get an effect that doesn't match your sequence.



Then, double-click the file to load it back into the Viewer. Click the Controls tab at the top of the Viewer 
window to display the settings for this effect. Click the Configure button to open up the interface.

The interface is divided into two sections: the Navigation Pane, on the left, and the image controls, on 



the right. 

By default, the Navigation Pane shows images stored in the Picture folder of your Home directory. 
While useful, I try never to store images, or any other project data, in my Home directory.

So, in the Navigation Pane, just above the gray text stating "Drag additional source folders here" I 
control click, which allows me to import any folder into the application. I find using this method is easier 
than reducing the size of Final Cut to see the Finder, then dragging a folder into the interface; though 
dragging in a Finder folder works just fine, too.

NOTE: Although you would think you can drag folders from the Browser into 
PhotoMotion, you can't. You can only drag folders from the Finder. 

ANOTHER NOTE: I've tried putting aliases of folders into the Pictures folder, but have 
found that, frequently, PhotoMotion doesn't see aliases.

Select an image from the Navigation Pane and drag it into the window on the right.

Once you've added an image, the movement controls appear. Here's where the fun starts!



  
  
  
  
  
  
  
  
  
  

The image on the left is where your animation starts. The image on the right is where it ends. The five 
sliders control:

1. Scale 
2. Rotation 
3. Horizontal position 
4. Vertical position 
5. Delay before, or after, the animation

You can use the sliders, but there's a much cooler way. Just put your mouse in the middle of an image. 
Rolling the scroll wheel zooms in or out, while dragging the picture repositions it. (Rotation and delay 
require using the sliders.)

To preview your move, click the Play button in the lower center of the screen. This generates a realtime 
playback of your effect. Continue tweaking until you are happy.

OTHER TOOLS

Across the bottom are other tools that provide features that don't exist in Final Cut itself.

You can switch between viewing the Navigation panl or seeing how much of an image you are using in 
your move.



You can save animation styles. Create something once and use it over and over again. (I find this of 
limited use, simply because the composition in each of the images I use is different. However, if you are 
using similarly composed images, this could be a real time-saver.)

Switch the starting and ending positions. This is a very cool trick. You decide that you need to zoom out, 
rather than in. Click this button and everything flips; instantly. In Final Cut, I'd have to move each and 
every keyframe; painful.

You can cancel out all movement by clicking this button (valuable, I'm sure, but I've never used it).

You can minimize thin line flicker by turning this on. I've found this works sometimes, and other times I 
get better results by adding a small - between 0.5 - 1.0 - of Gaussian Blur to the clip.

You can add acceleration or deceleration to the beginning, middle, or end of a movement. This is 
REALLY helpful because you can start to craft exactly how quickly an image takes off or lands. I use 
this a lot. The slider to the right of the button allows you to select how much acceleration you want to 
use.

When you are happy with your move, click OK.

The animation is now a clip in your Timeline that you can edit like any other clip. To go back and make 
changes, double-click the clip to load it into the Viewer, go to the Controls tab, click Configure and 
tweak.



CREATING SEQUENCES

For me, the real power of PhotoMotion comes in when creating sequences of clips. In Final Cut, we 
work with each clip individuall; in PhotoMotion Producer, we can work with clips in groups. 

Here's how.

From the Generator menu, select SlickFX Generators > PhotoMotion Producer.

This loads an empty sequence into the Viewer. This time, DON'T edit it to the Timeline. Instead, click 
the Controls tab and click Setup Slide show.

What we are doing here is constructing a sequence of images, in the order we want them to appear, 
adding transitions and default animation, then editing them into either a new project or an existing 
project.



When I first started using this feature, I dragged each individual image from the left side to the right. As 
sequences got longer, this got harder and harder to put an image exactly where I wanted it in the stack. 
A MUCH easier way to work is to select all the images in a folder by selecting the first image, Shift-
clicking the last image - which selects all images in a folder - and then dragging the entire group into 
the pane on the right.

Since we already organized all our images in the correct order by file name (see the section on 
Workflow above), this instantly creates the entire animated sequence, using default settings.



Using the slider at the bottom, you can change the duration of an individual image by selecting the 
image then dragging the slider - OR - what I find much easier, select all the images by selecting one, 
then pressing Command+A, and adjust the Duration slider so that all images have the length you 
need. 

This is a great way to get all your images to sync up to the beat of the music.

Remember earlier I mentioned you can save animation styles? Well, the pop-up menu just above the 
Duration slider allows you to set an animation style to all selected images.

Change the order of slides by dragging. Remove slides by highlighting and deleting them. Insert slides 
by dragging from the Navigation pane into the image list at the position you want the new image to 
occupy.

Very easy and very fast.



When you are happy with your sequence, click Build.

You can either create a new project for your images, or create a new sequence and add it to the 
Browser of an existing project.

Click Create and your new sequence is created. It automatically adds the default video transition 
between all slides, adds handles, and adjusts keyframes as necessary.

At this point, you can treat each image as any other clip, or, if you want to adjust the animation, double-
click the clip to load it into the Viewer and adjust as you would any other PhotoMotion clip. (We 
discussed this process earlier.)

THINGS TO WATCH OUT FOR

Opening folders containing huge numbers of files can cause problems. What I do, instead, is to copy 
just the images I want to use into a separate folder, which allows me to organize and rename only the 
images I want to use.

Creating huge sequences can also cause problems. I try to limit each sequence to 50-75 images. Since 
I can edit as many sequences as I want to the Timeline, this isn't a big deal.

Not all image formats are supported. I consistently had good results with PNG (I tend to avoid JPEG for 
quality reasons, but these are supported too.) Some TIFF formats seem not to be supported.



Also, folder contents are only read when you start the application. Adding an image to a folder after 
PhotoMotion has started does not update the Navigation Pane.

Finally, I've found that the Navigation Pane doesn't always read image orientation accurately. Slides 
come in rotated. Since I have rotation control as part of the animation, this, too, isn't a big problem to fix.

THE REAL BENEFITS

PhotoMotion offers several time-saving benefits when creating moves on stills:

1.  You don't need to prep your images, or compensate for the differences in pixel aspect ratios.
2.  You don't need to pre-size your images.
3.  If you are adding transitions, handles are generated automatically and the animation adjusts to 

accommodate the transition
4.  If you change the duration of a clip, the duration of the animation changes as well, so you never 

need to reset keyframes
5.  Once edited to the Timeline, an animated clip behaves just like any other clip, so you can add 

FCP filters, color correction, or motion effects, without changing your animation.

Using PhotoMotion Producer allowed me to create a 100-image montage, with custom moves and 
timed to the music, in about three hours. The last time I did this using only Final Cut Pro, it took me two 
days, and I was still wrestling with adding transitions and tweaking keyframes up until I needed to create 
the final output.

PhotoMotion saves me time and gives me more control, with greater flexibility. Plus, it's fun to play with.
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REPORT: FIXING CORRUPTED PROJECT FILES

First, a bit of background. I've written in the past about problems that can occur when project files get 
larger than about 100 MB. While rare, once a project file gets corrupted, it is very hard to get it restored 
to health.

This prompted Peter Sasowsky to write:

The documentary project file I had been working on for more than six years had grown to 
a size that I was not aware to be much too large – over 300megs. I had been working 
close to this size with no issues on a macBook pro with an external 2gig Glyph drive for 
more than a year, so was surprised when the file would not open. Going back several 
days into autosaves did not produce workable files. Copious backup files also seemed 
corrupted. In order to rule out FCP issues I upgraded to 7. I also copied all media files to 
a new drive to rule that out. Along the way I performed normal safety measures like 
cache removal, preference dump and running disk utility and Disk Warrior. The point at 
which the project file crashed each time was the same – it would load, find the media, 
then bring up the “preparing to display video” progress bar. When that completed it would 
crash. This lead me to believe that there was a corrupted sequence. On Larry’s 
recommendation I tried to use the new function in 7 that allows for opening a project with 
no sequences open. Unfortunately, because the projects had to update (recall that they 
were in 6 when corrupted), I was not able to get to the place where that keystroke would 
take effect.

Because this project is in near final stages of editing, it became my goal to save the most 
recent master sequence and not worry about the multitude of others. I knew I could 
always go back to the media directly and find clips I needed. Many suggested that I try to 
copy all the sequences into a new project, one by one to eliminate the one that was 



corrupted. But since I now could not open the project this was not an option. Then it 
occurred to me that I should try to open the project WITHOUT connecting to the media. If 
it was indeed a display issue, that might be eliminated. This worked. I unplugged the 
drive and the project opened. BUT, for some reason… I still could not copy and paste the 
sequences into a new project file. Frustration. There was one last thing to try now that I 
had the project open: I exported an XML of the master sequence, opened a new project 
and imported. 95% of the media relinked.

The result is that I now have a much smaller file (17megs) and have retained all of the 
edit decisions that were current. Give that the bins and sequences beyond that were lost, 
I still have a little more work to do when searching for files, but I can now take the time to 
rebuild that as I need it.

Larry adds: Peter, thanks for this write-up. I appreciate your taking the time.
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WHAT DOES 64-BIT REALLY MEAN?

With the release of Adobe's CS5 suite of products, there followed a flood of 
upgrades from a variety of other vendors, all of whom were touting their new 
support for 64-bit RAM memory addressing.

NOTE: 64-bit memory addressing affects how you use the RAM you 
have installed on your computer. Memory refers to RAM. Storage 
refers to hard disks. Memory disappears when you turn the power off; 
storage does not.

While Final Cut Studio does not yet support 64-bit RAM addressing, I thought 
a basic primer on why 64-bit is such a big deal might be helpful. My 
understanding has come from reading Apple's website and many discussions 
on The Buzz and in person with a variety of software engineers.

To get started, we need to understand that the operating system determines how much RAM an 
application can access. Up until recently that limit was 4 GB. Engineers used the term "32-bit memory 
allocation." 32-bits is a short-hand way of saying 2 to the 32nd power.

A 32-bit limit means that any Macintosh application that does not support 64-bit RAM addressing (which 
is everything except very recent applications) is limited to 4,294,967,296 bytes of RAM. (This is where 
the 4 GB term came from.) 

You can take advantage of installing more RAM in your system when you run multiple applications, 
because each application can live in its own 4 GB section of RAM, but no single application can use 
more than 4 GB. This means that for applications that need lots of RAM - think Photoshop or video 
processing - the applications need to spend a lot of time swapping temporary files between RAM and 
the hard disk (see the article on Activity Monitor later in this issue). Swapping files works fine, OS X is 
especially good at it, but it takes time and decreases performance.

However, when we move to 64-bit RAM addressing, these limits are VASTLY increased. 

The new limit means that a single application can theoretically access 18,446,744,073,709,600,000 
bytes of RAM! (I, ah, calculated this in Excel.) That translates to 18 EXAbytes of data! Huge!! Huge 
BEYOND HUGE!!! So vast that RAM access is essentially unlimited for the foreseeable future.

NOTE 1: Storage goes: Bytes, Kilobytes, Megabytes, Gigabytes, Terabytes, Petabytes, 
Exabytes and more beyond that...

http://www.apple.com/macosx/technology/#sixtyfourbit
http://www.digitalproductionbuzz.com/


NOTE 2: Having ACCESS to all this storage is only part of the solution. The next step is 
that you need to have more RAM installed on your computer system. Currently, the 
maximum amount of RAM that a MacPro can hold is 32 GB. So, this means that even 
though we can access 18 Exabytes of RAM, we can't yet install anywhere close to that 
much in our systems!

With this expansion in addressable memory comes two other benefits: By increasing the amount of the 
application that is stored in memory, the operating system needs to do fewer disk swaps, loading in 
different parts of the program depending upon what you are doing. And, second, many plug-ins that 
emphasize video processing are also writing in support for rendering using the Graphic Processing Unit, 
rather than the CPU. These two changes have the potential for applications to run significantly faster.

Additionally, according to Apple, 64-bit addressing allows CPUs to crunch twice the data per clock 
cycle, which means numeric calculations speed up considerably.

So, 64-bit RAM addressing is a good thing. Its here now with Adobe CS5 and Avid Media Composer 5; 
and I feel pretty confident that it will be coming in the next release of Final Cut Studio; whenever Apple 
decides the new version is ready to release.

[ Go to Top. ] 

THOUGHTS AFTER THE TUMULT: 
WHITHER GOEST FINAL CUT PRO?

Well, about a week or two ago, the Internet went ballistic over rumors that Apple was "walking away 
from Final Cut Pro." 

I did a blog posting at the time about this (you can read it here), but I just wanted to revisit this, briefly, in 
this issue.

First, Apple is not walking away from Final Cut Pro. It makes too much money and creates far too many 
benefits for the rest of the company in terms of R&D, visibility in Hollywood, and general bragging rights 
-- all of which are very valuable to Apple. 

Final Cut Pro isn't going away.

But the hoo-haw this created speaks to a bigger issue: we assume that software updates happen 
magically and can be cranked out on a whim. Neither of these are true.

Final Cut Pro is a MASSIVE program - involving tens of millions of lines of code. Making changes is like 
steering a very large ship -- nothing happens quickly and all changes take careful planning.

OF COURSE Apple is working on a new version. I don't have to have inside knowledge (and I don't) to 
guess that Apple is deep into rewriting the application to support all the latest features in Snow Leopard. 
Even Apple has acknowledged this. 

That update won't come soon -- but it will come.

My feeling is that we already have a very solid editing system that we can use today. I've NEVER had a 
client that demanded I edit on the latest version of FCP or OS X. Client's aren't that bright -- they just 
want to get their projects done on-time and on-budget. (In fact, I have clients that have not yet figured 
out that I'm editing on a computer!)

If it takes Apple a year more to come out with a new version, I can still get my work done with the 
current version.

http://www.larryjordan.biz/app_bin/wordpress/archives/1155
http://news.cnet.com/8301-13579_3-20005409-37.html


If I need 64-bit support and faster rendering, I'll switch to Adobe Production Premium -- which I also 
have installed on my system. No one is forcing me to use Final Cut. I use the tool that best helps me get 
the job done. Same as you. 

As Mike Horton says: "Take a deep breath, people. Stop panicking."

I'm looking forward to the next version of Final Cut Studio - but I'm not stopping what I'm doing now to 
wait for it. And I'm not paying attention to the rumor sites as they try to spike ratings by getting us all 
stirred up.

Life is too short.
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A NEW WAY TO CREATE CALL-SHEETS

When I was doing production on a daily basis, I was working in video creating live events, 
documentaries, and programs with exceedingly quick turnaround for broadcast.

Most of these projects needed to be shot in just a few days, sometimes in less than a day. So the call 
sheets I worked with were primarily focused on three issues: when does the crew show up, when is 
lunch, and when do we go home.

It wasn't until I started my current training business that I started to regularly work with folks who were 
creating films. Here projects could take weeks, or months, to shoot. And the needs for keeping track of 
all the details involved in production became much more complex.

This was reinforced to me last week in an interview Mike Horton and I did on the Digital Production 
Buzz. We were talking with Arnie Sirlin, the founder of eCallSheet.com, a startup that is trying to move 
the entire process of notifying crew and keeping things on track to the web.

(You can listen to the interview here.)

One of the issues that troubles me about moving critical data to the web is security. Once you move 
information up to the Internet, you lose a great deal of control over how that information gets 
disseminated. And Arnie and I talked about that a great deal during our conversation.

This morning, Arnie sent me a short note about an update he's made to the program:

Security was an issue that concerned you - especially, re: personal contact info. The 
program already offers a number of ways of dealing with it. 

But, after our conversation, a ridiculously simple solution popped up. Just like passwords 
are disguised in fields via bullet points or asterisks, the same can be done with telephone 
numbers and addresses. Voila!!! A very simple fix.

Currently, eCallSheet is in beta and Arnie has waived any fees for using it. If call sheets are important to 
you, check out this site and give Arnie feedback on how he can make it work better for you.
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http://www.digitalproductionbuzz.com/Archives/ShowNotes.php?date=2010-05-27


UNDERSTANDING AVCHD DISCS

Sourabh Chakraborty asks:

I am a huge fan of your newsletters. I see you mention in quite a few newsletters burning 
an AVCHD disc (on a standard DVD) using FCP 7 that will give greater quality than a SD 
DVD. Could you please go over the process?

Larry replies: Here's the short answer..

An AVCHD disc is a standard DVD with Blu-ray formatted media on it. You can create this in Final Cut 
Pro 7 (using File > Share and picking Blu-ray Disc) or Compressor 3.5.

In all cases, you take HD media, compress it into the Blu-ray format, then burn it to a standard DVD 
using the DVD burner inside your Mac.

The benefit to this is that you can use standard DVD media and burn it on your Mac. The disadvantage 
is that a standard DVD only holds 20-30 minutes of material, using a slightly lower data rate than typical 
Blu-ray Discs, which means the quality is better than standard DVDs, but not quite as good as a Blu-ray 
DVD.

For more information, look up Blu-ray in the Final Cut Pro on-line manual, or read the next article.
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A TESTIMONY TO BLU-RAY

David Scott writes:

Larry, I don't know if any of your other newsletter readers are Blu-Ray newbies like me 
but I've successfully used a Mac to burn Blu-Ray files onto both Blu-Ray media and 
standard DVDs. The resulting images - even when blown up on a good, High Def 
projector onto a 69x110 screen are - may I be presumptuous? - fabulous! All was done 
on a Mac via Toast Titanium Pro (with Blu-Ray plug-in), an external LaCie D2 
Professional 8x Blu-Ray burner and the Mac's own Superdrive. Incredibly, it was easy 
and I experienced no "gotchas." Here are two examples.

HOUR-LONG PRO-RES PROGRAM

In the first, I had a 93 Gig ProRes .mov file that I simply dragged onto Toast Titanium 
Pro's Blu-Ray work window. I selected "Automatic" under Encoding and "Best" as the 
Video Quality option. After loading a 25 Gig-capacity Maxell Blu-Ray disk, I then clicked 
on the red "burn" button and after a reasonable amount of time (between one and two 
hours, I think) I had a perfect, high def Blu-Ray disk that, so far, as played in every Blu-
Ray player I've tried. It looks superb on a 67-inch DLP TV as well as a high-quality NEC, 
ceiling-mounted projection system on a 130-inch diagonal screen. The enlarged Blu-Ray 
version is indistinguishable from the 93 Gig file played via QuickTime Pro at best 
resolution from a laptop.

A visual inspection of the Blu-Ray disk suggests only about half was burned. Had I 
selected Toast's "Custom" option, I could have chosen a higher bit rate and - perhaps - 
even better quality. However, it's hard for me to imagine a visible improvement.

NINE MINUTE FCP SHOW



In this instance, I prepared a nine-minute program in Final Cut. I then selected "Share" 
under the File menu. In the drop-down menu next to the blue icon, I chose "Blu-ray," 
checked "Create Blu-ray Disc, selected my Mac's Superdrive under "Output Device (will 
include AVCHD designation) then "Export." I was prompted to insert a disk (used an 
ordinary blank DVD, not a Blu-Ray one) into my Mac's Superdrive and my disk was 
burned. The disk plays spectacularly in a Blu-Ray player but it contains a "BDMV" folder 
containing the Blu-Ray encoded version of my program that easily is burned onto 
additional, ordinary, standard DVDs. Again, the result was (to my eyes) pristine. Better 
yet, I am able to mass produce these with a Primera Bravo SE DVD duplicator - again, 
onto ordinary DVD media.

Heretofore I've been a driven fanatic when it comes to image resolution - both in DVDs 
for home use as well as projected presentations for an audience about about 150. 
Obviously, quality swiftly drops when enlarging SD files. But self-burned Blu-Ray is a 
revelation! My projected shows are infinitely better and now I can offer either standard or 
Blu-Ray versions on disks to my distribution list. (I now want to figure out how to but both 
versions on one disk so that each is menu-selectable or, better still, defaults to 
accommodate Blu-Ray whenever the hardware is available.)

It is worth noting that both the TV/projector AND the Blu-Ray player must be properly 
adjusted for maximum quality. I guess some hardware combinations will automatically do 
this but I found one new Sony Blu-Ray player, out-of-the-box, fell short because default 
settings were not optimal for the NEC projector I was using. The picture was very good 
but not what I expected. Once I got into the player menus and tweaked those settings, 
the image suddenly snapped to perfection.

Larry adds: Thanks, David, for taking the time to write this.

UPDATE - May 31, 2010

Fred Tims asks:

I have two issues with the Share Menu's Blu-ray feature. 
 
1. With the BD-R discs that I burn, the "Skip" button on my Sony BDP-S301 player does 
not work. Is it just me? The player? FCP7? The chapter markers are indeed there and 
can be addressed by using the Top Menu. The Skip function also works fine with discs 
that I burn using Toast. 
 
2. My other issue is using Title Graphics over Share's pre-built menus. When it works, 
PSD files with transparency can look great. Problem is, transparent backgrounds don't 
always work. Why? Is there a certain attribute that my PSD files must possess? 
 
Thanks Larry. Any help will be greatly appreciated.

Larry repiies: Fred, I have no idea. If a reader has a suggestion, I'll pass it along. 

UPDATE - June 3, 2010

Todd Buhmiller adds:

Larry, I want to thank you for your newsletter, I always get it, kinda read it and then forget 
about it. Last night I was encoding some hd to sd and having issues with qmaster. To 
make a long story short, I read yesterdays newsletter and the article that intrigued me 
was the Blu-Ray testimony.

I never thought to take HD and put it into Toast and let Toast do the encoding and then 
burn a SD disc.

I was able to take a 80 min shoot of full 35Mb sec XDCam video, cut it up into two 40 min 



clips, and then burn two SD discs in 60 min.

That has helped so much that I had to write you to tell you and thank you.

Larry replies: Thanks, Todd, for writing. It really makes me happy when I can help. 
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PASSING THOUGHTS

Short notes on interesting subjects.

UPDATED ARTICLE 

I've updated my article on organizing and archiving your system. You can read the new version here. 

ANIMATING TEXT

Alec Schreck writes:

I may do a political gig (a video project in DC) that requires a fair amount of text dropping 
in over video

I know neither Motion nor After Effects. In the interim, can you suggest any FCP plug-ins 
that are a good substitute for Motion/AE for motion graphics, titles, etc?

Larry replies: Alex, you have lots of options.

Title 3D is great at creating text, but very limited for animation.

LiveType is a great text animator - simple and easy to use. FCP 7 supports it, provided 
you already have it installed on your system.

MoType from Yanobox. Website: www.yanobox.com

The Text Collection from CHV-Electronics. Website: CHV-Plugins.com

You can also animate using Keynote and export as a QuickTime movie.

If readers submit other choices, I'll be happy to add them.

UPDATE - June 3, 2010

Martin adds:

I love all of these plugins, but especially these text ones:

http://alex4d.wordpress.com/2009/03/30/free-final-cut-plugin-lower-third/

http://www.larryjordan.biz/articles/lj_archive.html
http://www.yanobox.com/
http://www.chv-plugins.com/
http://alex4d.wordpress.com/2009/03/30/free-final-cut-plugin-lower-third/


http://www.pureandapplied.com.au/demos/bettertext.html

Larry replies: Thanks, Martin, for the update. I had the pleasure of meeting Alex during one of my UK 
trips. I'm embarrassed that I didn't think of his plug-ins sooner. 

UPDATE - June 5, 2010

DL Haffner add:

Another GREAT option is Zaxwerks Pro Animator plugin for Final Cut Pro and Motion. It's 
a little pricey, but the results are Network quality.

Here is a link to an intro I built, using both. I also created the 3D Graphics in Pro Animator.

Go to: www.Vidvertise.com and play the video in the Camera.

Larry replies: Thanks, DL. 

FREE STUFF

Mark Besh sent me this:

Larry, just came across these sites/plugins/freebies:

�●     http://www.finalcutters.com/
�●     http://www.digital-heaven.co.uk

FREEBIES -- Grids and Guides for FCP!!!

�●     http://www.digital-heaven.co.uk/freeware
�●     http://www.digital-heaven.co.uk/dh_guides-tutorial
�●     http://www.digital-heaven.co.uk/dh_grid-tutorial

Larry adds: Thanks for the reminder! I've known Martin Baker, who runs Digital Heaven, for a long time. 
It is always nice to see that his work is appreciated.

LOOONNNGGGG RENDERS

John King sent this in:

Larry, this screenshot should give you a chuckle... remind me to use faster hard drives!

http://www.pureandapplied.com.au/demos/bettertext.html
http://www.vidvertise.com/
http://www.finalcutters.com/
http://www.digital-heaven.co.uk/
http://www.digital-heaven.co.uk/freeware
http://www.digital-heaven.co.uk/dh_guides-tutorial
http://www.digital-heaven.co.uk/dh_grid-tutorial


AVI CODEC

Al Johnson sent this in:

I needed to convert a bunch of video files from different formats to AVI for my client to 
use in Powerpoint.

After a lot of experiments, I found that the codec that works the best is Cinepak.

Thought you'd like to know.

UPDATE - June 3, 2010

Martin adds:

I'm the Mac in a PC place. For video in Powerpoint, I make WMVs using Flip4Mac. Worth 
every cent many times over.

Larry replies: Thanks, Martin, for writing. 

FLYING PEOPLE WITHOUT WIRES

Steve A. Martin sent this:

Hi Larry, I found this on Eran Stern's site and thought I'd pass it along: http://www.sternfx.
com/tutorials/73

A tutorial on flying people without wires. Very clever.
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READER MAIL

TRANSCODING AVCHD

Alex Melli asks:

http://www.telestream.net/flip4mac-wmv/overview.htm
http://www.sternfx.com/tutorials/73
http://www.sternfx.com/tutorials/73


Like many people out there, I'm using a camera (Canon HFS100) that produces AVCHD 
files I want to use in FCP, but the files are HUGE...is it worth it?

Transcoding through FCP's Log and Transfer, I use the ProRes codec and it ends up 
being around 60 Gigs/hour of transcoded footage, originally recorded in MXP (1920x1080 
@ 34 Mbps) and taking about 8 Gigs as data on the card.

I did a test or two, recording samples at the lowest bit rate LP mode, 5 Mbps, then 
transcoding with ProRes (Proxy) and comparing...maybe I'm daft, but they look identical 
on the monitor to me! (And only 18 Gigs/hour.) Am I missing something? Will something 
unexpected happen further down the line, or is the quality so high, even at the lowest 
setting, that it all looks great? (I'm used to DV, which now all looks soft by comparison.)

Larry replies: Alex, thanks for writing!

For AVCHD material, the general consensus is to convert it to ProRes 422, not HQ or 4444; see my 
earlier article in this issue. You can also use ProRes 422 LT, but the lowest level - ProRes 422 Proxy - 
has a lot of compression artifact and should not be used for anything where image quality is important.

With FCP, you can't edit AVCHD natively it has to be transcoded.You can use either ProRes or the 
Apple Intermediate Codec (AIC). ProRes is always the best choice, unless you have a very old 
computer, in which case, AIC is better.

Generally, you copy the files from the card to a folder on your hard disk first (one folder per card) then, 
use Log & Transfer on the contents of the folder. That way, if you need to go back to the source media, 
you have it on your hard disk.

[ Go to Top. ] 

AN ANALOGY FOR BIT-DEPTH

Tim Kotthoff writes:

For several years I have enjoyed your analogies and explanations as I have read books, 
newsletters, and watched videos that you have authored. I am currently enjoying your 
guidance in my MacProVideo account.

I recently read this article and I am still processing the information. http://www.larryjordan.
biz/articles/lj_video_bit_depth.html

May I ask for some clarification in the area of bit-depth in the world of video?

I understand that bit (binary digit) depth is the measurement of gray scale (shades of 
color or gray) in an image (how realistically an image is represented).... or as you 
explained the number of steps between our lowest low and highest high (between black 
and white).

My question relates to 8 bit video. With banding being a problem with mastering (color 
grading) and output, when HDV/XDCAM are converted to ProRes, how does 8 bit video 
become 10 bit video? I understand that a lot of consumer/prosumer cameras are 
recording codecs for spacial efficiency that are then transcoded for editing efficiency 
(from long GOP to I-Frame). It makes sense that there is an interpolation that occurs to 
go from long GOP to I-Frame.

http://www.larryjordan.biz/articles/lj_video_bit_depth.html
http://www.larryjordan.biz/articles/lj_video_bit_depth.html


Larry replies: Tim, this is a great question.

The easiest way to think of this is that 8-bit video is like water filling a one-quart container. 10-bit video 
is like water filling a 1 gallon container.

Converting 8-bit video to 10-bit is like pouring the water from a one-quart container into a one gallon 
container. You haven't added more water, or changed it in any way, but you have given yourself more 
space to do other things with it.

The benefit is that when you start to add effects or do color correction, you have much more space in 
which to work, with the final result being higher quality.
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DROPLETS VS. COMPRESSOR

Steve Bowers asks:

I was wondering if you have a newsletter or document that describes how to use 
compressor separate from FCP? I just tried to drop the project onto the droplet and it 
wouldn’t do anything. 

I guess I don't understand then why go to all the trouble to make a droplet if I have to 
export my project anyhow to make a movie to drop onto the droplet. 
 
Why not export it to compressor in the first place and be done with it?

Larry replies: Steve, these are good questions.

If you Export > Using Compressor, the export will take significantly longer than real-time to export. 
Generally, 4-8 times longer than real-time.

If you Export > QuickTime Movie, assuming your sequence is fully rendered, exporting will take 
between 6 and 50 times FASTER than real time to export. 

So the first reason is speed.

Second, because Compressor does its work in the background, once you drop a file on a Droplet and 
click Submit, you can go back and edit in Final Cut. For me, dropping a file on a droplet and clicking 
submit takes about ten seconds. When Final Cut is exporting using Compressor, the entire FCP 
application is tied up and no other work can be done - generally for hours. This, also, results in a loss of 
productivity.

This is why I recommend using droplets - FCP is freed up MUCH faster for new projects or additional 
editing.

NOTE: The Export Using Compressor option does not exist in FCP 7. Instead, FCP 7 
allows Sending a file to Compressor. This, too, works in the background and is a good 
choice when you need to customize a compression setting. For me, I prefer having a high-
quality master file of my project, which is why I prefer exporting a complete movie, then 
compressing it.
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EXPORTING H.264 VIDEOS

Jeffry Abelson writes:

I was just watching your tutorial for exporting H.264 videos and have two questions 
relative to videos that will stream on the internet.

You say to check the Deinterlace box. But what if your original video is progressive to 
begin with ?

You also say to check the Optimize for Download in the Data Rate area. But all the 
hosting sites I'm looking at (like Vimeo) say to to optimize for Streaming. This is made 
further confusing by everyone saying to check to Prepare for internet streaming (Fast 
Start).

What's the right answer on the former (Optimize for Download or Streaming)?

And what is the difference between these two internet settings (Optimize vs. Prepare)?

Larry replies: Jeffrey, thanks for writing.

1. If your video started as progressive, don't deinterlace.

2. If you are hosting the video on your own site, click "Optimize for Download." If the 
hosting service provides specific settings for their service, follow their guidance. "Prepare 
for Internet - Fast Start" is the same thing as "Optimize for Download." This is a download 
setting, not a streaming setting.
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AVOIDING DROPPED FRAMES

Jimi writes:

I got a question about Final Cut 6. This just started happening...I keep getting that darn 
warning dropped frames message.

Larry replies: Jimi, Your scratch disks are screwed up. Dropped frames almost always indicate 
problems with a hard drive that's too slow. Be SURE to double-check that your scratch disks are 
pointing to a second drive, not your boot drive or home directory.

Generally, this isn't a permissions or preference issue, but scratch disks that are either set incorrectly or 
too slow (in which case run a repair utility to fix them.)

In fact, I'm doing two webinars in early June on solving Dropped Frame problems. You can learn more 
about them here.
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PROTOOLS VS SOUNDTRACK PRO



Trevor Hughes writes:

[Your new STP tutorials] sound interesting. I have sound editors helping me out and they 
use ProTool,s which I have on my Macs. But every time I look at it I go "oh, no!" I don't 
won't to go there.

I think I do a pretty good job in Soundtrack Pro and understand the work flow and lay out 
but am I get the best.

I went to a sound guy who was using Logic for a sound track Now I thought Logic was 
just a music thing but as I watched I saw him use the same filters come up there as in 
Soundtrack Pro. So I am thinking, is there any good reason to get Logic? Does it do a 
better job? Is the work flow as easy as with Soundtrack Pro?

Larry replies: Trevor, thanks for writing!

I could talk about your questions for hours, but here's the short version.

1. The filters inside Logic and Soundtrack are the same. However, Logic is designed for 
music creation and Soundtrack is designed for mixing. That's why Soundtrack is bundled 
with both Final Cut Pro and Logic. You CAN do music mixing in Logic, the same way you 
can do audio mixing in Final Cut, but neither was really designed to be used for that 
purpose.

2. Film and broadcast mixing involve more than levels. Film, in fact, requires a mixing 
stage roughly the size of the theater your audio will be displayed in. Broadcast has very 
stringent technical specs that vary by network. Some of the technical specs run for 
pages. These are very hard to present in either an article or a short video tutorial.

3. The audio challenges for DVD, podcasts, or web posting are much less stringent. So, 
for people just getting into audio, this is a great place to start to learn how the tools work 
and how to improve the quality of your sound.

4. There's nothing wrong with ProTools. It is an excellent tool. However, there are 
features in Soundtrack Pro that ProTools can't do - one of them being that it is bundled 
with Final Cut Pro, which means you already have the software installed on your system.

5. The Mac does not use a sound card. The built-in hardware and software is perfectly 
fine for even the highest quality work. Generally, however, you would want to connect 
your external audio gear via USB or FireWire, not plug into the headset jack of your 
computer.

6. My tutorials only cover STP, not Logic. Also, my tutorials primarily focus on mixing 
human speech, not music. Mixing music uses different filters, different workflow -- but the 
same tool. The interface and operation remain the same, but the process is different.

Hope this helps.
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CREATING AN AUDIO CD IN SOUNDTRACK PRO

Vasan asks:

Is it possible to make individual tracks from one long music track in Soundtrack Pro? In 



Adobe audition, it is simple and straightforward. I was not able to find that info including 
your tutorial.

Larry replies: Yes, Vasan, easily. There are two ways to do this. If one doesn't work, the other will.

To create an audio CD, you need to create individual clips for each track you want to place on the CD.

OPTION 1

* Place your playhead at the start of the clip you want to export 
* Type the letter "i" (without the quotes) 
* Place your playhead at the end of the clip you want to export 
* Type the letter "o" (without the quotes) 
* Make sure SubMix 1 is set to Stereo output (Tracks 1-2) 
* Select File > Export with the following settings:

- Master mix 
- AIF 
- 16-bit depth 
- 44.1 kHz sample rate

OPTION 2

Earlier versions of STP didn't always recognize the In and Out, so try this.

�●     STP exports from the start of your sequence until the end. The end is defined EITHER as the 
point where there are no more audio clips, or where the Mark > End of Project marker is placed.

�●     Using the Razor Blade (press the letter "B") cut the clip at the beginning and at the end of the 
portion you want to export

�●     Move the clip to its own track
�●     Mute all other tracks
�●     Place your playhead at the end end of the track you want to export
�●     Select Mark > End of Project marker
�●     Make sure SubMix 1 is set to Stereo output (Tracks 1-2)
�●     Export as above.

However you decide to create your separate tracks, Roxio Toast is EXCELLENT at burning your audio 
CD.

UPDATE - June 2, 2010

Peter Neil, of the BBC London adds:

I know this doesn't answer the original question - which was about achieving this in 
Soundtrack Pro, but by far the best way I've found is to use SoundStudio 3

You open the long track and then insert markers at each break point (including one at the 
beginning) and then Edit > Split by markers and it saves each section as a separate 
track. If you bother to name the markers with the track names, the saved sections will be 
similarly named. It's possible to save in several audio file formats, or as AIFF for burning 
using Toast (or, indeed, iTunes).

A trial copy of the application can be downloaded from hwww.freeverse.com/mac/
product/?id=5012 which can be opened, I think, 10 times before you have to pay for it.

Larry replies: Thanks, Neil. I was not aware of this program. 
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DVD STUDIO PRO IMPORTING

Michael Loftus asks:

Using DVDSP 4, I can import SD video into DVDSP without having to convert it from a .
mov file to .mv2 and DVDSP will do the conversion. But HD video has to be converted in 
compressor. Is there a technical reason for this, or is it just the way Apple designed it.

Also, is there a way to convert 4:3 title menus to 16:9 in DVDSP?

Larry replies: Michael, DVD Studio Pro can not convert 4:3 images to 16:9; you would need to use 
Photoshop to do that.

DVD SP can compress SD video, which is why you can import it. However, it can not compress HD 
video into Blu-ray, only into HD-DVD, which is a video format that died two years ago. This is why you 
need to use Compressor.

However, for best results, I recommend compressing both HD and SD materials in Compressor, then 
bringing the results into DVD SP for authoring.
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CHANGING INCORRECTLY SIZED ANAMORPHIC FOOTAGE

Howie Z. writes:

Hello Larry. I bought a Apple power MAC G-5 quad 2.5ghz DDR2 desktop pc. I loaded it 
with FCP system 5.0. I captured the footage I shot via firewire. It went into the computer 
fine.

Problem. The footage was shot a a Sony PD150 in anamorphic mode. When I capture 
the footage into FCP it goes to a 4X3. I have tried adjusting my setting but the outcome is 
still the same. 

I don’t understand what happened. The first project I did the computer captured it in 16X9 
but now I can’t get it to capture that way again.

Larry replies: Thanks for writing, Howie!

There are two ways to fix this:

1. Make sure your Final Cut Pro > Easy Setup is set to DV NTSC Anamorphic BEFORE 
starting to capture.

- or - 

2. After capturing the clip, select the clip(s) in the Browser, then scroll right and check ON 
the Anamorphic flag.

As the pixel count is exactly the same for both 4:3 and 16:9, all you really need to do is tell FCP that the 



pixels should be shaped for anamorphic (wide-screen) video.

UPDATE - June 3, 2010

Paul Frederick adds:

Larry, the PD-150 never shot in Anamorphic mode! It merely letterboxed the footage in a 
4x3 frame!! Nothing he could do would ever make that footage anamorphic since that 
camera was incapable of shooting it that way! The PDX-10 actually shot anamorphic. 
Before that it it was only LTBX in 4x3 frame.

Just thought I'd let you know this, I love your newsletter and you do a great job!

Larry replies: Thanks, Paul, for the update. 

UPDATE - June 5, 2010

Shaun Roemich writes:

Actually, the PD150 DID shoot Anamorphic video BUT it extracted it from the centre 360 
pixels (instead of 480) so you DID get anamorphic video BUT it was stretched vertically, 
thereby lowering resolution significantly. We shot an indy film this way on my old PD150 
and I was never convinced it was any good at anamorphic, but it WOULD do it.

The video that is generated HAS an Anamorphic flag coming off of tape and is encoded 
to the full Ana DV frame BUT was extracted from a 4:3 sensor using centre cut the same 
as if it was letterboxed and then trimmed in the first place, only stretched out to fit to 
"pack the pixels"

Larry replies: Wow, weird. Thanks! 
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USING EDLS WITH TAPELESS MEDIA

Nguyen asks:

I have watched your very good tutorial about EDL. It is very clear and precise.

Can you help me for this problem: Normally, once EDL is set up, I switch ON the VTR 
(connected to the Mac) and my role is to change tapes of the VTR every time the Mac 
ask me.

This is my request: I have HDCAM SR shots in hard drives, but NOT in HDCAM SR 
tapes. I have converted HDCAM SR into DVCAM for editing. 

Now, I finish the edit with DVCAM shots, how to make EDL with Hard drives instead of 
with HDCAM SR VTR deck?

Larry replies: Nguyen, thanks for writing.

This has either a really good answer, a bad answer, or a really bad answer. When you are working with 
files, you don't need an EDL. EDLs are principally used for tape.



The Good Answer 
If, when you created the DVCAM files, you matched the file name, timecode, and frame rate, all you 
need to do is create a new sequence with an HDCAM setting, and reconnect media from the low-res 
DVCAM files to the hi-res HDCAM files. 
Fast and easy.

The Bad Answer 
If, when you created the DVCAM files, you did not match the file names, but did match the timecode, 
you will need to manually reconnect each file.

The REALLY Bad Answer 
If, when you created the DVCAM files, you did not match the file name OR the timecode, then you will 
need to re-edit everything.

UPDATE - May 31, 2010

Mike Krause sent this in:

Here'a a fix I'd like to suggest to Nguyen who might have problems connecting to some 
DVCam dubs. If it turns out he is stuck with the "really bad answer" I might have a 
solution. 

I had a very similar job recently; long story short, he might be able to use Modify > 
Timecode for the DVCam conversions/dubs he made, and change the timecode to 
match the masters. 

If the names are the same but the DVCam TC doesn't match, as long as the frame rate 
matches he'll be in business.

And if nothing else, this might elevate his problem from "really bad" to just "bad" if he has 
to manually change the TC and reconnect for every clip. It might be better than starting 
over depending on his project.

Larry repiies: Thanks, Mike. 
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A "KEYFRAME EVERYWHERE" COMMAND

Eric Hvisc asks:

Larry, is there a command that set a key frame for every element on every track selected. 
freezing every thing in place at that point on the time line. does motion have such a 
command?

Larry replies: Not to the best of my knowledge, no.
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QUESTION ABOUT ACTIVITY MONITOR

Peter Tours asks:



Since you showed it to us at your seminar in Miami, I have found it entertaining to watch 
Activity Monitor, filling those idle moments...or hours of render or export.

I am currently exporting an 8 minute sequence, DVC PRO HD and the sequence is a 
movie with a lower third movie over it. There are a few dips where I lose the the lower 
third, but overall it's an animation file with an alpha over a DVCPROHD file. The 
computer is saying 4 hours to export using current settings, again, DVC Pro HD. This 
seems extreme.

I have no idea what real memory or virtual memory could be except what they appear to 
be, so how come I am using an ounce or RAM and a ton of hard drive?

Maybe the solution is don't look at Activity Monitor, but I don't drink tea and have to pass 
the time somehow.

Larry replies: Thanks for writing, Peter.

Here's a screen shot of Activity Monitor running on my system to illustrate what Peter is asking.

If you look in the top half of the screen, you'll see two columns: Real Memory and Virtual Memory. (If 
you don't see these, control click on a column header and select them from the list.)

First, we don't care about real or virtual memory. UNIX, the foundation of OS X, cares a LOT. So much 
so, in fact, that it does a great job of managing all this memory stuff so we don't have to worry about it. 
(For the record, the Virtual Memory is the total amount of memory being accessed by that application. 
Real memory is that amount of the Virtual memory which is paged into RAM from the hard disk. 

The reason FCP is taking so long to output your file is that it is doing is analyzing, processing, and 
exporting each frame - one frame at a time - for your export. So, since it is only working with a single 



frame, it doesn't need a lot of memory. The low hard disk rate is due to the fact the computer can't 
calculate any faster to create a bigger data stream. And the reason it can't calculate any faster is the 
FCP only uses 1.5 of your processors, even though you have eight.

That last fact won't change until we get a version of FCP that is rewritten for Snow Leopard. (See my 
earlier article on 64-bit addressing.)

And, yes, I confess, I enjoy watching Activity Monitor, too. You can find it in Utilities > Activity Monitor.
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WRAP-UP

Well, that's about it for this issue. I'm still wading thru all the email, I'll put more answers in my blog.

For current news and in-depth interviews on what's happening in our industry, be sure to listen to the 
Digital Production BuZZ every week. In fact, put the free BuZZ player on your web site! It's fast, 
simple, and very cool.

Also, please consider supporting this newsletter by:

�●     Registering for one of my webinars.
�●     Buying a tutorial - decrease your stress and get back to work. 
�●     Or, buy a mouse pad -- you know you need a new one... 

Also, please continue sending me your comments and questions. I love hearing from you and enjoy the 
conversations that develop around your comments.

Until next month, take care, and edit well.

Larry
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